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About this guide

This guide provides the steps required to install the hardware and initially configure
the single-node Model G02. For procedures explaining how to replace components
and change configuration settings, refer to the IBM TotalStorage NAS Gateway 300
Model G27 Hardware Installation Guide and the IBM TotalStorage NAS Gateway
300 Model G27 User’s Reference.

The Model G02 does not support clustering. When you are following procedures in
the IBM TotalStorage NAS Gateway 300 Model G27 User’s Reference, any steps
that address clustering are not applicable to the Model G02. For example, if the
IBM TotalStorage NAS Gateway 300 Model G27 User’s Reference instructs you to
“power down the first node,” then you will power down your only node and ignore
the sequence for “power down the second node.”

Who should read this guide
This guide is intended for anyone responsible for setting up the Model G02.

Publications

Hardcopy publications shipped with the NAS Gateway 300 Model G02
The following publications are shipped in hardcopy and are also provided in
softcopy form at www.ibm.com/storage/support:

v IBM TotalStorage NAS Gateway 300 Model G02 Installation and Initial Setup
Guide

This publication provides procedures for setting up, cabling, and replacing
components of the Model G02.

v Safety Information-Read this First

This publication contains general safety information translated into different
languages.

v IBM TotalStorage NAS Gateway 300 Model G27 Hardware Installation Guide

This publication contains some hardware installation and replacement
procedures. This guide applies to the Model G27, but certain procedures also
apply to the Model G02. Always consult this guide first.

Related publications
The following publications are available on a CD-ROM shipped with this product
and at www.ibm.com/storage/support:
v IBM TotalStorage NAS Gateway 300 Model G27 User’s Reference

This manual describes how to configure and use the software provided with the
product.

v IBM TotalStorage NAS Gateway 300 Model G27 Hardware Installation Guide

This guide describes the installation procedures for this product and is intended
for the customer.

v IBM TotalStorage NAS Gateway 300 Model G27 Hardware Service Guide

This guide describes the service procedures for this product and is intended for
trained service personnel.

v IBM TotalStorage NAS Gateway 300 Model G27 Quick-Start Instructions

© Copyright IBM Corp. 2003 v
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This publication does not apply to the Model G02, but is provided for
informational purposes. It describes how to install the dual-node Model G27.

v IBM TotalStorage NAS 100, 200, and Gateway 300 Planning Guide

This guide explains how to plan for the installation and use of the NAS Gateway
300.

The following document is available only on the CD-ROM:
v IBM TotalStorage NAS Translated Safety Notices

This booklet contains translations of safety notices specific to this product.

Accessibility
The softcopy version of this guide and the other related publications are
accessibility-enabled for the IBM Home Page Reader.
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Chapter 1. Introduction

Note
This guide is the only document that is specific to the Model G02. The Model
G02 is the single-node version of the dual-node Model G27. That being the
case, most of the documentation for the Model G27 also applies to the Model
G02. The hardware is identical for the two models, except that there is only
one engine included with the Model G02 and two engines included with the
Model G27. The major differences are that the Model G02 does not support
clustering or domainlet configurations. All of the other information that applies
to the primary node in the Model G27 documentation applies to the Model
G02.

To take advantage of the similarities, the existing Model G27 documentation is
also included with the Model G02. This document will refer to the Model G27
documentation when appropriate.

The NAS Gateway 300 connects clients and servers on an IP network to Fibre
Channel storage, efficiently bridging the gap between local area network (LAN)
storage needs and storage area network (SAN) storage capacities.

This appliance offers a storage solution for both Microsoft® Windows®, UNIX®, and
UNIX-like environments, including mixed Windows-UNIX environments that enable
Windows and UNIX clients and servers to share the same Fibre Channel storage.

The Model G02 replaces the Model G01. Enhancements provided by the new
model include:

v More options in configuring Ethernet connections

v More options in configuring Fibre Channel connections

v More options for tape backup

v Faster processor

v Faster adapters

The single-node Model G02 features:

v One engine (IBM 5187 NAS Model 7RY), with:
– Dual 2.4-GHz processors
– 512 MB of ECC memory plus one upgrade of at least 1 GB (minimum

memory is 1.5 GB); up to 4.5 GB available
– Two redundant hot-swap 560–watt power supplies
– Qlogic 2340 1-port Fibre Channel adapter for SAN connection
– Six PCI adapter slots for plugging in optional adapters. Two slots are 133

MHz, three slots are 100 MHz, and one slot is reserved for the RSA card.

v Optional adapters:
– Alacritech 100x4 Quad-Port Server Accelerated Adapter
– IBM Gigabit Ethernet SX Server Adapter
– IBM PCI Ultra160 SCSI adapter (LVD/SE)
– Alacritech 1000x1 Single-Port Server and Storage Accelerated adapter
– PRO/1000 XT Server Adapter by Intel
– Qlogic 2340 1-port Fibre Channel adapter or Qlogic 2342 2-port Fibre

Channel adapter (to replace single-port Fibre Channel SAN adapter)
– Qlogic 2340 1-port Fibre Channel adapter for tape backup
– Remote Supervisor Adapter

© Copyright IBM Corp. 2003 1



The preloaded software stack is based on the Windows Powered OS operating
system, which is very similar to Microsoft Windows 2000 Advanced Server.
Preloaded software includes:

Microsoft Windows 2000 for Network Attached Storage
Enables remote administration of the appliance using a Web-based
graphical user interface (GUI).

Microsoft Windows Terminal Services
Enables remote administration of the appliance using its Windows desktop.

Microsoft Services for UNIX
Provides file access to UNIX and UNIX-based clients and servers through
the Network File System (NFS) protocol. Note that the NAS Gateway 300
supports Linux and other platforms that employ NFS.

IBM Director Agent and Universal Manageability Server Extensions
Provides system management support based on industry standards (in
conjunction with the IBM Director console application as well as other
management software).

IBM Advanced Appliance Configuration Utility agent
Supports management through the IBM Advanced Appliance Configuration
Utility console application (supports aggregate Web-based management of
all of your IBM appliances).

IBM FAStT Management Suite Java (MSJ)
Provides diagnostics for the Fibre Channel adapters.

Intel® PROSet II
Provides diagnostics for the Intel Ethernet adapters.

Alacritech® SLICuser
Provides diagnostics for the quad-port and accelerated Ethernet adapters.

Columbia Data Products® Persistent Storage Manager (PSM)
Provides 250 persistent images of customer data and enables full online
backup of system with Microsoft backup applications.

Tivoli® Storage Manager Client
Provides data backup and archive support (in conjunction with Tivoli
Storage Manager Server).

Tivoli SANergy™

Provides shared data access to the SAN storage at Fibre Channel speed.

Services for NetWare
Provides interoperability within the Novell environment and a complete set
of new interoperability services and tools for integrating the Model G02 into
existing NetWare environments. Only Netware V5.0 Print and File services
are included in the preloaded code and is required for supporting Netware
File system protocol. Clustering is not supported by the SFN5.

Storage Manager for SAK
A storage management tool that includes storage reports, directory quotas,
and file-screening functions.
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Chapter 2. Installation

This chapter describes how to install the Model G02.

Preinstallation checklist
Ensure that you have the following items in addition to this guide:

v 5187 Model 7RY engine

v Power cords (2)

v CD-ROMs (7)

v Enablement diskette

v Rack-mounting kit

v Rack-mounting installation instructions and template

v Cables necessary to connect to Ethernet network and storage

If you ordered options, your package might contain additional hardware, software,
or publications for those options.

If an item is missing or damaged, contact your place of purchase.

Initial installation
The initial installation consists of the following steps:

v Rack installation

v Installation testing

Rack installation
Refer to the Rack Mounting Instructions included with the appliance.

Installation testing
Test your installation by powering on the appliance (refer to “Powering on and off
the Model G02” on page 6 for this procedure). Each time the appliance is powered
on, it automatically runs a self-testing program to ensure that it is running correctly.
If the power-on diagnostics complete successfully, one beep will sound and the
information LED and the system error LED on the operator information panel are
off. See Figure 1 on page 4 for the location of the operator information panel, and
Figure 2 on page 5 for the location of the LEDs on the operator information panel.

© Copyright IBM Corp. 2003 3
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�1� Operator information panel
�2� Power button shield (if installed)
�3� Power button

Figure 1. Location of the operator information panel
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If a problem is detected, refer to the IBM TotalStorage NAS Gateway 300 Model
G27 User’s Reference. If you are instructed to power down the appliance, refer to
“Powering on and off the Model G02” on page 6.

After the power-on diagnostics have completed successfully, you can install any
additional optional adapters that you might have ordered for your engine. For
information on installing additional adapters, see the IBM TotalStorage NAS
Gateway 300 Model G27 Hardware Installation Guide.

TX
RX

OK

1/

1 2 3 4

567

�1� Power-on LED: This green LED is on when system power is present in the
appliance. When this LED flashes, the appliance is in standby mode (the
system power supply is turned off and ac power is present). If this LED is
not on, the power cord is not connected, the power supply has failed, or
this LED has failed.

�2� POST complete (OK) LED: This green LED is on when POST completes
without any errors.

�3� Hard disk drive activity LED: This green LED is on when there is activity
on the internal hard disk drive.

�4� Information LED: This amber LED is on when the information log contains
information about certain conditions in your appliance that might affect
performance. For example, the LED is on if your appliance does not have
functioning redundant power. An LED on the diagnostic panel on the system
board will also be on.

�5� System error LED: This amber LED is on when a system error occurs. An
LED on the diagnostic panel on the system board will also be on to further
isolate the error.

�6� Ethernet transmit/receive activity (TX/RX1) LED: This green LED is on
when there is transmit or receive activity to or from the appliance on the
integrated Ethernet port.

�7� System locator LED: This blue LED can be turned on remotely to identify
a specific engine.

Figure 2. LEDs on the operator information panel
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Powering on and off the Model G02
The following sections list the steps necessary to power on and shut down the
Model G02.

Powering on the Model G02
Follow this procedure to power on the Model G02:

1. Power on any uninterruptible power supply and allow it to return to normal
operation.

2. Power on any network hubs or switches.

3. Power on the Model G02.

Shutting down the Model G02
Follow this procedure to shut down the Model G02:

1. Select Start → Shut Down and select Shut down from the drop-down menu.

2. Click OK.

3. You can power off any network hubs or switches that are used exclusively by
the NAS Gateway 300. If they are used by other network attached devices, do
not power off.

4. You can also power off any uninterruptible power supplies that regulate power
for the NAS Gateway 300, provided that no other equipment that you want to
keep powered on is plugged into the same uninterruptible power supply.
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Chapter 3. Setup and configuration

This chapter gives details to set up the initial communication to the Model G02 to
enable setup and configuration. These instructions refer specifically to a base
configuration as shipped and do not cover the setup of additional storage units,
which can be purchased separately.

A suggestion for first-time users . . .
Your understanding of the Model G02 and your ability to use it will be greatly
enhanced if you first proceed to the NAS Setup Navigator tutorial.

The NAS Setup Navigator maps out the initial configuration tasks and leads
you through the tasks in the proper order. The tool detects which NAS
appliance it is running on and adjusts the menu and content appropriately. You
can follow links to more in-depth information and to the configuration panels
used to perform the steps. You can also tailor the instructions to fit your needs
by selecting optional topics. The Navigator allows you to enable the functions
and features. To start the NAS Setup Navigator, click the NAS Setup Navigator
icon on the desktop.

After you have become familiar with the Model G02, you can refer to the IBM
TotalStorage NAS Gateway 300 Model G27 User’s Reference for more details.

Figure 3. Opening screen of the NAS Setup Navigator
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Note: References to “Public LAN” in the NAS Setup Navigator refer to the LAN
connection to the network, whether that is a public or internal network.

The following procedures explain the requirements and instructions for setting up
and configuring the Model G02. Following these directions and referring to the
appropriate sections of the IBM TotalStorage NAS Gateway 300 Model G27 User’s
Reference will help you in this task.

Prerequisites

v A domain controller must exist on the network and a login ID must be
defined.

v All Windows shared disks must be defined as basic. Windows 2000
dynamic disks are not supported.

v All shared storage must be defined as NT File System (NTFS) and be on
primary partitions.

v Compression cannot be enabled on any disk partition.

v The node must have a public adapter.

Configuration and administration tools

The Model G02 is a network-attached-storage appliance that has several
different methods of configuration depending on your environment.

First, determine how you will manage the device. You can manage the
Model G02 in either “headless” mode or with a keyboard, display, and
mouse directly attached to the engine. It is recommended that you directly
attach a keyboard, display, and mouse to the Model G02 when you are
performing the following procedures:
v Setting up and configuring the Model G02 for the first time
v Changing or adding RAID arrays defined on the fibre-attached storage
v Troubleshooting the device
v Managing when there is a single or few appliances in the network and

you use static setup and definition.

For “headless” management of the Model G02, you can use one of the
following tools:
v Windows Terminal Services

If Dynamic Host Configuration Protocol (DHCP) is installed and the IP
address requested can be determined, use this method for initial setup,
but you should change the address to static later in the configuration.
This condition is most appropriate when using Windows Terminal
Services for operation of the Model G02. See “Terminal Services and the
IBM NAS Administration console” on page 11 for more information.

v IBM Advanced Appliance Configuration Utility

If you have multiple appliances or cannot determine the DHCP address,
install the IAACU to identify appliances and define IP addresses. The tool
also allows you to set static addresses. See “IBM Advanced Appliance
Configuration Utility” on page 13 for more information.

v Universal Manageability Services (UMS)

Enables management through a Web browser. See “Accessing Universal
Manageability Services” on page 19 for more information.

v Windows 2000 for NAS

A Web-based GUI for those not familiar with the Windows desktop. See
“Windows 2000 for Network Attached Storage” on page 18 for more
information.

8 Model G02 Installation and Initial Setup Guide



After you determine how you will manage the Model G02, you can begin
setup and configuration of the device.

For more information on configuration and administration tools, see Chapter
3, “Configuration and administration tools” in the IBM TotalStorage NAS
Gateway 300 Model G27 User’s Reference.

Step 1 - Initial network setup

Configure the node to enable access over the network. The general steps
to do this are given below.

1. Use DHCP or static addressing to set up one public network connection
in the node.

a. If you are operating with a keyboard, display, and mouse, set up a
public network connection to access the device.

b. If you are operating in a headless environment, use one of the
following methods:

v If DHCP is installed and the IP address requested can be
determined, you can use DHCP for initial setup, but you should
change this address to static later in the configuration.

v If you have multiple appliances or cannot determine the DHCP
address, you can install the IAACU utility to identify appliances
and define IP addresses. With this tool, you can also set static
addresses.

2. Complete the steps in “Set the date and time” on page 19 and “Set up
the network” on page 19.

Step 2 - Define storage and setup partitions
The Model G02 attaches to your SAN-attached storage device, through the
Fibre Channel, and provides your Ethernet LAN-attached clients access to
that storage. You must define storage arrays and logical drives on the
SAN-attached storage device and set up Windows partitions on the logical
drives as defined in Chapter 4, “Setting up storage” in the IBM TotalStorage
NAS Gateway 300 Model G27 User’s Reference.

For more information on defining storage and setting up partitions, see
Chapter 4, “Setting up storage” in the IBM TotalStorage NAS Gateway 300
Model G27 User’s Reference.

Note: If you are attaching an IBM TotalStorage Enterprise Storage Server,
follow these steps to set the TimeOutValue in the Windows 2000
registry of your Model G02:

1. Click Start -> Run.

2. Enter regedt32.exe.

3. Navigate to the following registry key: HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControlSet\Services\Disk.

4. Locate the value called TimeOutValue. If the value exists,
continue with step 5 on page 10. If the value does not exist,
create it by following this procedure:

a. Click Edit -> Add Value.

b. In the ValueName field, type TimeOutValue.

c. In the Data Type field, select REG-DWORD from the
drop-down list.

d. Click OK.
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e. In the Data field, type 3c.

f. Select the Hex radio button.

g. Click OK

h. Skip to step 6

5. If the value is less than X'0000003c' (60 decimal), complete this
procedure to increase it to X'0000003c'

a. Click TimeOutValue.

b. Click Edit -> DWORD.

c. In the Data field, type: 3c.

d. Select the Hex radio button.

e. Click OK.

6. Exit the regedt32 program by closing the window.

7. Restart the Model G02 to allow the new settings to take effect.

Step 3 - Complete network setup

1. Power on the node.

2. Set up the node:

See “Configure the local area connection” on page 20 and “Add the
appliance to a domain” on page 21.

Step 4 - Additional functions

Additional functions are available for backup, persistent images, and adding
more storage areas. It is recommended that after you complete the setup
and configuration procedures, you use the Persistent Storage Manager
Disaster Recovery option (see “Disaster recovery” in the IBM TotalStorage
NAS Gateway 300 Model G27 User’s Reference) or other method to back
up the system configuration in the event of a failure.

Also, it is imperative to use the system shutdown procedure described
in “Powering on and off the Model G02” on page 6 to ensure system
integrity.

For more information, see Chapter 6, “Managing and protecting the network
and storage” in the IBM TotalStorage NAS Gateway 300 Model G27 User’s
Reference.

Select the configuration and administration tool
Table 1 suggests which tool to use for specific functions, but does not list all options
or combinations. The administrator’s training level or preferences might determine
an alternate approach from that suggested in the table.

Table 1. Summary of configuration and administration tools for the Model G02

Administration tool Main functions

Windows Domain Controller (not NAS
appliance)

Users and user groups can be defined and authenticated by the Windows
Domain Controller, although this is not required.

IBM Advanced Appliance
Configuration Utility (IAACU)

Access a headless Model G02 node, particularly for the initial setup of the
network connectivity. (Alternatively, you can attach a keyboard, mouse,
display to the Model G02.) IAACU enables you to:
v Set time, date, and initial network connectivity parameters
v Access Windows 2000 for NAS GUI, Terminal Services (NAS Desktop),

and Universal Manageability Services
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Table 1. Summary of configuration and administration tools for the Model G02 (continued)

Administration tool Main functions

Windows 2000 for NAS GUI Provides ease-of-use administration, but not all the capabilities of Terminal
Services and IBM NAS Administration. The GUI enables you to:
v Configure public LAN connections
v Create and format logical drives
v Join domains
v Set up access permissions and disk quotas for CIFS, NFS, HTTP, FTP,

and Novell NetWare shares
v Use Persistent Storage Manager

IBM NAS desktop and IBM NAS
Admin program, through a Terminal
Services session or a directly
connected keyboard and monitor

Provides in-depth administration of all aspects of Model G02. Provides all of
the Windows 2000 for NAS GUI functions above, plus the ability to:
v Use NAS Backup Assistant, or NT Backup and Restore wizard
v Learn detailed inventory information about hardware, OS, and so on, using

Universal Manageability Services
v Diagnose system problems:

– Check the onboard Ethernet controller using the Broadcom Advanced
Control Suite.

– Check Ethernet adapters using PROSet II, SLICuser, or both,
depending on which adapters are installed.

– Check Fibre Channel card using FAStT MSJ.

Disaster Recovery Restores a previously saved PSM image of the system partition to a failed
machine. This restores all configuration information on the failed node. You
create the recovery boot diskette from the PSM tools in the Windows for
2000 NAS GUI.

Recovery CD-ROM Set Reinstalls the software to the original state as shipped on the machine;
however, does not restore configuration information (configuration changes
you applied to the original shipped configuration are lost). You must first boot
with the Recovery Enablement Diskette, and then reboot with the Recovery
CD-ROM. To create the Recovery Enablement Diskette, run
enablement_disk_x.y.exe (where x.y are the version number of the disk),
located on the Supplementary CD-ROM. You will be prompted to insert a
blank disk into drive a:.

Integrated System Management
Processor (ISMP) configuration
program

Configures the ISMP that is integrated on the engine planar board.

Remote Supervisor Adapter (RSA)
configuration program

Configures the optional RSA.

Terminal Services and the IBM NAS Administration console
If you are familiar with Windows operating systems, you can use Terminal Services.
In some cases, you must use Terminal Services to complete administrative tasks.

You can access Terminal Services in two ways:

1. Through the UM Services browser, as described in Starting UM services in the
IBM TotalStorage NAS Gateway 300 Model G27 User’s Reference.

2. By using the Terminal Services Client software.

Installing Terminal Services
To use the Terminal Services Client, complete the following steps to install it on the
remote workstation and connect to the Model G02 appliance:

1. Insert Supplementary CD-ROM #2 into the workstation CD-ROM drive.

2. Select Start → Run.

3. In the Open field, type (with quotation marks)
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"x:\Terminal Services Client\Disk 1\setup.exe"

where x is the drive letter assigned to the CD-ROM drive.

4. Click OK to begin the Terminal Services Client Setup program.

5. Accept the defaults in each window that opens or refer to the Microsoft
Windows documentation for more instructions.

6. When the Terminal Services Client Setup program completes, ensure that the
workstation has network connectivity to the NAS appliance so that you can
administer the appliance.

Connecting to the desktop through Terminal Services
To connect to Terminal Services from your workstation, do the following:

1. Click Start → Programs → Terminal Services → Terminal Services Client.

2. In the Server field, select the computer name of the appropriate Model G02. If
that Model G02 is not listed, type the IP address or the computer name of the
Model G02. The computer name is predefined as IBM5196-xxxxxxx, where
xxxxxxx is the serial number located in the lower right corner of the bezel on the
front of the appliance. If you have changed the computer name from the
predefined value, use that name instead.

Note: Although you can do so, it is recommended that you not change the
default computer name to avoid the chance of propagating
misidentification through the system. And, if you are using IBM Director
to manage your appliance, and you change the default name, the default
name continues to appear in IBM Director.

3. For Size, select a screen size in which the Model G02 desktop will appear. It is
recommended that you choose a size other than full screen.

4. Click Connect to start the Terminal Services Client session. A user login window
opens.

5. Log in. Type Administrator in the Username field, type password in the
Password field, and then click OK to log in. After you log in, you can begin
using Terminal Services Client to configure and manage the Model G02, as if a
keyboard, mouse, and monitor were directly attached to it. The Model G02
desktop contains a shortcut, titled IBM NAS Admin, to a special console, the
IBM NAS Administration console.

IBM NAS Administration console
The IBM NAS Administration console includes all the standard functions provided by
the standard Computer Management console available on any Windows 2000
desktop, plus the following advanced functions specific to the Model G02 (see
Chapter 6, “Managing and protecting the network and storage” in the IBM
TotalStorage NAS Gateway 300 Model G27 User’s Reference):

v NAS Backup Assistant

v Persistent Storage Manager

Determining who is using the network-attached storage
Occasionally, you might want to know who is using the network-attached storage.
To determine this information:

1. Start a Windows Terminal Services session from the administrator’s console to
the Model G02.

2. Click the IBM NAS Admin icon on the desktop.

3. In the left pane, click File Systems → Shared Folders → Sessions.
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4. The users currently using the storage are displayed. To close those sessions,
use a right-click. Before you close a session, notify the user that you are going
to close the session by clicking Start → Programs → Accessories → Command
Prompt, and then issuing the net send hostname messagetext command.

IBM Advanced Appliance Configuration Utility

Note: Although you can do so, it is recommended that you not change the default
computer name of your NAS appliance to avoid the chance of propagating
misidentification through the system. Also, The IBM Advanced Appliance
Configuration Utility (IAACU) depends on the original name to function.

The IBM Advanced Appliance Configuration Utility helps you to set up and
reconfigure the network configuration on the Model G02 appliance, as well as other
IBM appliances.

The IAACU agent, preinstalled on the Model G02 appliance, works with the IAACU
console, a Java-based application that is installed on a network-attached system.
You can use the IAACU as a systems-management console to automatically detect
the presence of Model G02 appliances on the network. After the Model G02
appliance is detected by the IAACU console, use the IAACU to set up and manage
the appliance’s network configuration, including assigning the IP address, default
gateway, network mask, and DNS server to be used by the appliance. You can also
use the IAACU to start Universal Manageability Services (UM Services) on the
appliance, enabling you to perform more advanced systems-management tasks.

For networks that are not currently running DHCP servers, the IAACU is useful for
automatically configuring network settings for newly added appliances, such as the
Model G02.

However, networks with DHCP servers will also benefit from using the IAACU
because it enables you to reserve and assign the appliance IP address in an
orderly, automated fashion. Even when you use DHCP and do not reserve an IP
address for the appliance, you can still use the IAACU to discover appliances and
to start UM Services Web-based systems management.

Notes:

1. The IAACU configures and reports the TCP/IP settings of the first adapter on
each appliance. The “first” adapter is determined by its position. If there is a
connection to the onboard Ethernet controller, then this is the first adapter. If
there is no connection there, then it will make slot 2 the first adapter.

Be sure to connect the first adapter to the same physical network as your
systems-management console. You can do this by manually configuring the
network adapter to be on the same subnetwork as the systems-management
console.

2. The IAACU must be running to configure newly installed appliances
automatically.

3. The system running the IAACU console automatically maintains a copy of its
database (ServerConfiguration.dat) in the Advanced Appliance Configuration
Station installation directory (Program files\IBM\iaaconfig). To remove previous
configuration data, close the IAACU, delete this file, and then restart the utility.
This deletes all previously configured Families. However, the IAACU will
automatically discover connected appliances and their network settings.
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Installing the IBM Advanced Appliance Configuration Utility
These instructions assume that you have installed and powered on the appliance
according to the installation procedures. You are now ready to install the IAACU
console application from the Supplementary CD-ROM.

Install the IAACU console application from the Supplementary CD-ROM onto a
Windows NT® 4.0 or Windows 2000 workstation that is attached to the same IP
subnetwork to which the appliance is attached.

Note: The IAACU creates a private database that is specific to the IP subnetwork
to which it is attached. Therefore, do not install it on more than one
systems-management console residing on the same IP subnetwork.

After you install the IAACU console application, the following steps will take you to
the point where you can administer the appliance.

1. Start the IAACU console application by clicking its icon.

2. On the left pane of the Advanced Appliance Configuration console, select the
appliance to administer. Initially, the appliance name is IBM5196-serial number;
the serial number is located in the lower right corner of the bezel on the front of
the appliance.

3. Click Start Web Management to start the UM Services browser. This will open
a separate Web browser window.

4. Proceed to “Accessing Universal Manageability Services” on page 19.

For more information on the IAACU, see “IAACU console”.

Initial network adapter selection and connection to the IAACU

IAACU agent
The IAACU agent is preinstalled on the Model G02 appliance.

After you connect the Model G02 to your network, the IAACU agent automatically
reports the appliance serial number and type, the MAC address of its onboard
Ethernet controller, and whether DHCP is in use by the appliance. Furthermore, it
reports the host name, primary IP address, subnet mask, primary DNS server
address, and primary gateway address if these are configured on the system.

Note: The IAACU agent periodically broadcasts the appliance IP settings. To
prevent the service from broadcasting this data periodically, stop the
iaaconfig service.

IAACU console
The IAACU console is a Java application that you install on one system in your
network for use as a systems-management console. For information on how to
install the IAACU console, see “Installing the IBM Advanced Appliance Configuration
Utility”.

Note: The IAACU creates a private database that is specific to the IP subnetwork
to which it is attached. Therefore, do not install it on more than one
systems-management console residing on the same IP subnetwork.

The IAACU console enables you to:

v Automatically discover Model G02 appliances, as well as other IBM appliances
that run the IAACU agent and are attached to the same physical subnet as the
IAACU console.
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v Use a GUI-based application to configure the appliance network settings.

Use the IAACU to assign network parameters such as IP addresses, DNS and
gateway server addresses, subnet masks, and host names.

v Start UM Services Web-based systems-management console.

Launch UM Services on your appliances and perform advanced
systems-management tasks on a selected appliance with a single mouse click.

The IAACU console is divided into two panes:

v Tree View Pane

The Tree View Pane, located on the left side of the IAACU console window,
presents a list of all discovered Model G02 appliances. The Tree View Pane also
includes groups for appliances that were not configured using the IAACU or that
have IP addresses that conflict with other devices on your network. When you
click any item in the Tree View, information about that item (and any items that
are nested below that item in the tree view) appears in the Information Pane.

v Information Pane

The Information Pane, located on the right side of the IAACU console, displays
information about the item that is currently selected in the Tree View Pane. The
information that appears in the Information Pane varies depending on the item
that is selected. For example, if you select the All Appliances item from the Tree
View Pane, the Information Pane displays configuration information (IP settings,
host name, serial number, and so on) about each of the Model G02 appliances
that have been discovered by the IAACU console.

The IAACU console also features the following menus:

File Use the File menu to import or export the IAACU console configuration
data, to scan the network, or to exit the program.

Appliance
Use the Appliance menu to remove a previously discovered appliance from
a group.

Help Use the Help menu to display product information.

Discovering Model G02 appliances: Any Model G02 appliance, or other IBM
appliance, that is running and is connected to the same subnet as the system
running the IAACU console is automatically discovered when you start the IAACU
console. Discovered appliances appear in the IAACU console tree view (in the left
pane of the IAACU console window). Every discovered appliance is listed in the
tree view under All Appliances.

Universal Manageability Services
Universal Manageability Services (UM Services) is a Windows application that
functions as both a stand-alone management tool for the system it is installed on
and a client to IBM Director.

As a Director Client, it receives and sends information to the Director Server as
controlled from the IBM Director Console.

As a stand-alone tool, it provides a Web-browser based interface and a Microsoft
Management Console (MMC) interface, where you can view the system status,
perform certain management tasks and configure alerts.
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The UM Services GUI enhances the local or remote administration, monitoring, and
maintenance of IBM systems. UM Services is a lightweight client that resides on
each managed computer system. With UM Services, you can use a Web browser
and UM Services Web console support to inventory, monitor, and troubleshoot IBM
systems on which UM Services is installed.

This “point-to-point” systems-management approach, in which you use a Web
browser to connect directly to a remote-client system, enables you to effectively
maintain IBM systems without requiring the installation of additional
systems-management software on your administrator console.

In addition to point-to-point systems-management support, UM Services also
includes support for UM Services Upward Integration Modules. These modules
enable systems-management professionals who use any supported
systems-management platform (including Tivoli Enterprise™, CA Unicenter TNG
Framework, and Microsoft Systems Management Server [SMS]) to integrate
portions of UM Services into their systems-management console. Because it was
designed to use industry-standard information-gathering technologies and
messaging protocols, including Common Information Model (CIM), Desktop
Management Interface (DMI), and Simple Network Management Protocol (SNMP),
UM Services adds value to any of these supported workgroup or enterprise
systems-management platforms.

You can use UM Services to perform the following tasks:

v View detailed information about your computers, including operating system,
memory, network cards, and hardware.

v Track your computers with features such as power management, event log, and
system monitor capabilities.

v Upwardly integrate with Tivoli Enterprise, Tivoli NetView®, Computer Associates
Unicenter, Microsoft SMS, and Intel LANDesk® Management Suite.

Complete documentation on how to use UM Services is included on the
Documentation CD-ROM that came with the appliance.

System requirements
The UM Services client is preinstalled on the Model G02 appliance. However, you
must have a Web browser installed on your systems-management console. It is
recommended that you set Microsoft Internet Explorer 5.x (or later) as the default
browser.

Notes:

1. You must install the optional Java Virtual Machine (VM) support to access a
client system running UM Services.

2. If you reinstall Internet Explorer after installing UM Services, you must reapply
the Microsoft VM update. The UM Services client requires Microsoft VM Build
3165 or later. Download the latest Microsoft VM from www.microsoft.com/java

3. If you install UM Services before you install MMC 1.1 (or a later version), you
will not have an icon for MMC in the IBM Universal Manageability Services
section of the Start menu.

Starting UM Services
You can use IAACU or Terminal Services Client to configure the network setting
remotely, or you can attach a keyboard and mouse to your appliance and configure
the Network settings using the Windows Control Panel. After you have configured
the network settings for your appliance, you are ready to use UM Services.
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To start UM Services:

1. Start a Web browser and then, in the Address or Location field of the browser,
type:
http://ip_address:1411

where ip_address is the IP address of the Model G02, and then press Enter.

Or, type:
http://computer_name:1411

where computer_name is the computer name of the Model G02. The computer
name is predefined as: IBM5196-xxxxxxx, where xxxxxxx is the serial number
located in the lower right corner of the bezel on the front of the appliance.

If you have changed the computer name from the predefined value, use that
name instead. A user login window opens.

2. Type Administrator in the User Name field, and type password in the Password
field. You can leave the Domain field blank. Make sure the Save this password
in your password list check box is not selected, and then click OK.

Note: To ensure system security, change the Administrator password from
“password” to something else. After you do, or if you create another user
in the Administrator group in the future, use your new
username/password combination instead of the default
username/password combination.

The first time you connect, you might be prompted to install XML and Swing
components. Follow the on-screen instructions to install these components and
then close and restart Internet Explorer before you proceed.

Figure 4. UM Services default page
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You are now connected to the Model G02 through UM Services. In addition to
the standard UM Services functionality, the appliance includes functionality for
administering the appliance, available from the Appliances tab in the left pane of
the UM Services browser. The default view (in the right pane of the UM
Services browser) when you connect to the appliance is Windows 2000 for
NAS. The other selectable view in the Appliances tab is Windows 2000 Terminal
Services, which displays a Terminal Services Web Connection page.

3. To start Windows 2000 for NAS, click Administer this server appliance in the
right pane of the UM Services browser. To connect to the Model G02 and
manage it as though you were running Terminal Services Client from the
desktop, select Terminal Services in the Appliance tab of the UM Services
browser, and then follow the instructions for connecting to the Model G02 using
Terminal Services described in “Terminal Services and the IBM NAS
Administration console” on page 11.

Launching UM Services from the configuration utility: You can use the IAACU
to launch UM Services on the Model G02 appliances.

Note: The selected appliance must be running UM Services as a UM Services
client. Also, the systems-management console (the system that is running
the IAACU console) must use a Web browser that is supported for use with
UM Services. If you have not used UM Services from this system, you must
install several plug-ins before proceeding.

To use the IAACU console to start UM Services on an appliance:

1. Click the appliance in the IAACU console Tree View Pane.

When you select the appliance from the tree view, information about the
selected appliance appears in the Information Pane.

2. Click Start Web-Based Management.

Your default Web browser starts, loading the UM Services browser
automatically.

3. Log in to the UM Services browser. Refer to Step 2 on page 17 for login
instructions.

For more information on using UM Services to manage your appliances, see the
Universal Manageability Services User’s Guide, included on the Documentation
CD-ROM that came with the appliance.

Windows 2000 for Network Attached Storage
While you can perform most administrative tasks using Windows 2000 for NAS, you
must use Terminal Services Client for some advanced tasks. See “Terminal
Services and the IBM NAS Administration console” on page 11 for more information.

Task categories available to you through Windows 2000 for NAS include:

v Status

v Network

v Disks

v Users

v Shares

v Maintenance

v Controller
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To start Windows 2000 for NAS, use one of these methods:

v UM Services, described in Step 3 on page 18

v Web browser, by entering http://ip_address:8099 or http://computer_name:8099
and then logging on to the Model G02

v Model G02 desktop while using Terminal Services Client and starting a browser

You can access online help for Windows 2000 for NAS in two ways:

1. Click the Help button at the top of any Web page. This displays a table of
contents that you can navigate to find help for any Windows 2000 for NAS task.

2. Click the question mark (?) button at the top of any Web page. This displays
context-sensitive help for the task you are currently performing.

Accessing Universal Manageability Services
1. You will be prompted to authenticate with the administrative user name

(“Administrator”) and password (initially “password,” but you can change it later;
note that the password is case-sensitive, but the user name is not).

If this is the first time you have accessed the UM Services browser (on any
appliance) from this workstation, you will also be prompted to install the Swing
and XML Java libraries in your Web browser. You can download these libraries
from the Model G02 through the network link.

2. The UM Services browser starts. In the left pane, Microsoft Windows 2000 for
Network Attached Storage is automatically selected on the Appliances tab. In
the right pane, Windows 2000 for Network Attached Storage starts.

3. Again, you are prompted to authenticate with the administrative user name and
password.

4. Click Administer this server appliance to bring up the Microsoft Windows
2000 for Network Attached Storage GUI.

You are now ready to begin administering the appliance. Details for this task are
described in the section “Initial setup and configuration” in the IBM TotalStorage
NAS Gateway 300 Model G27 User’s Reference.

Set the date and time
To change the date and time, click Date and Time. (Remember that you can also
access all of these task groups by clicking the titled tabs at the top of the page.)
The Set Date and Time page appears, allowing you to adjust information as
necessary.

Set up the network

Note: All appliances have an initial default user name of “Administrator” and
password of “password.”

As part of the Network task group, you can change the administrator password and
(optionally) you can configure the properties of each network interface that resides
on the appliance.

To change the administrator password, click Change Administrator Password.
The Change Administrator Password page appears, allowing you to change the
password. Note the warning on the page that any information that you enter can be
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viewed by others on the network. To prevent others from seeing your information,
set up a secure administration Web site as described in the online help.

To change IP addresses, click Interfaces. The Network Adapters on Server
Appliance page appears. Use this page primarily to change IP addresses from
dynamic (DHCP, which is the system default) to static.

Note: During the initial setup, you can configure either the onboard Ethernet
controller, or a nonplanar Ethernet adapter.

If you want to use an Ethernet adapter other than the onboard Ethernet
controller or the Ethernet adapter in slot 2 as the network interface to be
attached to the subnet, then you can change the order of precedence later
with the Windows Networking Properties option. The order of precedence for
the initial configuration is: onboard Ethernet controller, then PCI slot 2.

During initial setup, the IAACU first looks for an onboard Ethernet
connection. If that connection exists, it enables it. If there is no connection to
the onboard Ethernet controller, then it will enable the Ethernet adapter in
slot 2. You can then enable any other NIC interfaces by right-clicking the
adapter icon.

You must modify the adapter by completing the IP task (to modify IP configurations)
and then choosing one or more of the following tasks, as appropriate:

v DNS (to modify DNS configurations)

v WINS (to modify WINS configurations)

v HOSTS (to modify host configurations)

Configure the local area connection

Note: The network adapter’s IP address can be obtained automatically if a DHCP
server is available.

To configure the local area connection, perform the following steps:

1. Right-click My Network Places, and then click Properties.

2. Select a Local Area Connection.

3. To rename the connection, click Rename, and then type (for example) Public 1,
and press Enter. Ensure that local area connection names are unique.

4. Enter the networking addresses:
a. Right-click My Network Places.
b. Click Properties.
c. Right-click the Public icon, and then click Properties.
d. Select Internet Protocol (TCP/IP).
e. Click Properties, select Use the following IP address:, and enter the

addresses for the IP, subnet mask, default gateway, and preferred DNS
server.

5. If needed, configure the DNS, WINS, HOSTS, or whichever method you will be
using for names resolution. To view this information, click Advanced on the
Properties window.

Note: NetBIOS should be disabled.

6. Click OK on each panel to return to the Properties window.
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Do not place paired adapters on the same IP network unless you are going to use
adapter teaming or adapter load balancing.

Add the appliance to a domain
You will need the domain name, as well as the domain administrator username and
password to add the appliance to an existing domain. To add the Model G02 to a
domain, follow these steps:

Note:

1. On the Windows desktop, right-click the My Computer icon.

2. Select Properties.

3. Click the Network Identification tab.

4. Click Properties.

5. Select the Domain radio button.

6. Type the name of the domain into the text field.

7. Click OK.

8. When prompted, enter the domain administrator username and password for the
domain.

9. Click OK.

Verify network connectivity and names resolution
Verify network connectivity and names resolution.

To verify that the networks are communicating correctly:
1. Click Start → Run, type cmd in the text box, and click OK to bring up an

MS-DOS prompt.
2. Type ping ipaddress where ipaddress is the IP address of a different network

adapter, and press Enter.

You can do this from any machine that is physically connected to the network of
each node.

To view the address, use the ipconfig command on the node.
1. Click Start → Run, type cmd in the text box, and click OK to bring up an

MS-DOS prompt.
2. Type ipconfig and press Enter. IP information should appear for the connected

network adapter in the machine.

Create a disaster recovery boot diskette
Use of the NAS Disaster Recovery feature for backup of the C: to a local FAT32
partition (D:) or a network share requires the creation of a boot diskette. The
diskette is used to boot the recovering appliance and includes a DOS-based
operating system, as well as the location of the image of C: from which to restore.
You must make this diskette bootable. The NAS Administration GUI online help text
inaccurately indicates that this can be accomplished with a menu option in
Windows® Explorer. The correct method is as follows (excerpted from the IBM
TotalStorage NAS Gateway 300 Model G27 User’s Reference):

1. Insert a blank, formatted diskette in the diskette drive of the node.

2. On the Disaster Recovery page, click Create Disk.
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3. Click OK on the Create Recovery Disk page. The diskette drive LED will turn off
when the creation is complete. The diskette creation should take no more than
two minutes. Note that after you start the process of creating the backup boot
diskette, the user interface will not indicate when the diskette is finished. Follow
these steps to verify that the diskette is complete:

a. Wait until the diskette activity LED is consistently off.

b. Open Windows Explorer.

c. Select the diskette drive.

d. Verify that there are no changes occurring to the diskette (press F5 to
refresh).

4. When there are no additional updates to the diskette, execute “fixboot.exe”
(should be located in A:\fixboot.exe), which executes against A:\ to make the
diskette image DOS-bootable. From a command prompt, either through the
desktop of the node itself (with the diskette still in the diskette drive of the
node), or on another system with the diskette in its diskette drive, type:
a:\fixboot.exe

and answer the prompts.

5. Remove the diskette from the appropriate diskette drive. Label the diskette
appropriately and keep it in a safe place.
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Appendix A. Additional notes for release 2.7

This chapter contains the additional information about Release 2.7 of the IBM®

5196 TotalStorage™ NAS Gateway 300, Model G02.

Refer to www.ibm.com/storage/support/nas for possible updates to this information.

The 2.7 CD includes these drivers:

v ServeRAID™ 5.11

v Intel PROset II Version 5.3.42.0

v Alacritech SLICuser Package 5.34

v Drivers and firmware upgrades:

– ServeRAID Driver Version 5.11

– Intel Ethernet Gigabit Version 6.2.21.0

– LSI On-board SCSI Version 1.8.12

– Alacritech Ethernet Adapters

- Alacritech ATCP Driver Version 5.34.0.0

- Alacritech Simba Driver 5.32.0.0

– Adaptec SCSI LVD Win2k Device Driver Version 4.10.4000

Known problems and solutions
For Release 2.7, there are several known problems. Table 2 lists these known
problems and suggested solutions or workarounds.

Table 2. Known problems and solutions

Abstract Problem Solution or workaround

Problem installing
Veritas Backup Exec

During installation of Veritas Backup Exec 8.6, the
program attempts to create a new cluster group
and move resources (like the shared drive) into a
group called Backup Exec. During this process,
Veritas installation aborts with the following error
message:
Severe - Error in Creating the Cluster Group.

This problem may also happen when you are
using the Cluster Administration tool or
Cluster.exe tool to try to add a network resource
name that contains an underscore (_) character;
you might receive an error message that indicates
that the resource name contains invalid
characters.

Workaround: The workaround currently
is to manually create the groups in the
Cluster hive and to not use the
“underscore” character.

Server Wizard appears
during the login process

When logging on to the appliance using an
Administrative User other than the default
“Administrator” account, a wizard dialog is
invoked, prompting you to configure the engine.

This is normal behavior when a new
Administrative User logs on to the
appliance. A Server to-do list is
created every time a new
Administrative User logs on to NAS
Gateway 300. Bypass the wizard and
use the IBM NAS Admin.msc to
configure the appliance.
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Table 2. Known problems and solutions (continued)

Abstract Problem Solution or workaround

Disk Wizard completes
with error

If invoking the Microsoft Disk Manager when the
appliance has a hardware RAID Solution, and no
external Fibre Channel storage is attached, the
User sees a wizard for writing a signature to a
drive that is detected. The User finishes the
wizard and receives an error on completion that
Disk ″0″ is unknown.

This is normal behavior on Fibre
Channel and RAID-based appliances.
Connect the Fibre Channel to the HBA
and it should detect any configured
external Logical Volumes.
Note: The “Unknown disk” is the
“Pseudo disk” in Device Manager and
is used by Fibre HBA.

Plug-in does not start When selecting plug-ins in the IBM NAS
Administration console, the required plug-in does
not start.

Right-click the plug-in; then click
Refresh. This is standard Microsoft
Management Console (MMC)
behavior.

IBM Appliance Advance
Configuration Utility

The IBM Appliance Advance Configuration Utility
(IAACU) console does not allow the creation and
placement of the appliance within a designated
group or family.

This is normal behavior when the
IAACU Console has been updated to
support the latest appliances. This
may be addressed with a future
release of the console.

FTP virtual directory is
not displayed in directory
listing

A virtual directory in an FTP site cannot be seen
by the client.

Visit the Microsoft Web site for a
workaround to view the contents of an
FTP virtual directory.

ServeRAID Agent
terminated unexpectedly

When the appliance shuts down, the ServeRAID
agent logs an event to the System Event Log that
the agent has shut down unexpectedly.

This is normal behavior for the
ServeRAID agent, and the agent starts
normally when the appliance is turned
on.

Functional notes
The following sections contain functional information.

NFS share configuration in Server Appliance Kit

Error when assigning client group to an NFS share
When assigning a client group to an NFS share, you get the message:
The client machine name XXXX could not be resolved.

(where XXXX is the name of a defined client group)

To work around this problem, either:

1. Assign the IP address of the machine instead of using the client group name,
OR

2. Use the desktop interface by navigating to the actual folder that you want to
share using Windows Explorer; then right-click the folder and select Sharing.

Error when assigning machine IP address to an NFS share
When assigning a machine IP address, you get the message:
The client machine name XXXX could not be resolved.

(where XXXX is the IP address of a client on your network)

To work around this problem, either:

1. Ensure that the client machine is on the network and that you can ping it, OR
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2. Use the desktop interface by navigating the actual folder that you want to share
using Windows Explorer; then right-click the folder and select Sharing.

Reestablishing SNMP service
The SNMP Service has been turned off in Release 2.7 to increase performance and
security. This service can be turned on by following these steps:

1. Use Terminal Services or attach a monitor, keyboard, and mouse to the
appliance.

2. Double-click IBM NAS Admin Snap-in.

3. Expand Maintenance and click Services

4. Right-click SNMP Service and select Properties.

5. Set Service to “Automatic” or “Manual” (default is “Manual”); then click Apply.

6. To start SNMP service, click Start.

Persistent Storage Manager notes

FAT32 file system functional limitation
Persistent Storage Manager (PSM) does not allow a Persistent Image (snapshot) to
be taken of a FAT32 file system formatted volume. The Maintenance (D:) partition is
formatted FAT32 by default, to allow system restore from a DOS boot disk by a
back up of the system volume (C:) stored as a file on D:. Therefore D: must be
formatted FAT32. The NAS Backup Assistant can be used to backup C: to D: using
a PSM-generated snapshot to allow backup of open files. However, a PSM
snapshot-assisted backup of D: is not possible because D: must be a FAT32
volume, and attempted snapshot assisted backups of D: will fail.

You can back up D:, if you do not use PSM. Backups of D: that do not use PSM to
generate a snapshot will succeed as long as other variables (such as sufficient
space available on the destination volume) are correct.

Command line interface
PSM uses several system-level files, one of which has a command line interface.
Use of this is supported only for IBM-provided applications and services, as well as
use by IBM support technicians to assist in debugging problems. All PSM function
(including sophisticated scheduling and automation of remote management) is
provided by the GUI described in the IBM TotalStorage NAS Gateway 300 Model
G27 User’s Reference.

PSM failure to take a snapshot
Defragmentation of managed storage is often an essential maintenance task for
Windows machines. Defragmentation of a NAS that uses PSM is complicated by
the data protection activity of PSM. PSM caches all the old data that is overwritten
by the extra write traffic generated by the defragmentation engine. Therefore,
defragmentation of volumes with snapshots managed by PSM is disabled: the
defragmentation engine will complete and report success, but the volume will be
unchanged. However, defragmentation remains necessary, and PSM will even
cease taking snapshots if its cache file becomes too fragmented, reporting the
following errors to the System Event Log:
<date/time> psman5 Error None 4135 N/A <mach.name> A persistent image could not

be created due to error 0xe000103f.
<date/time> psman5 Error None 4159 N/A <mach.name> Cannot create PSM files

because the volume is too fragmented.

To successfully defragment the volume, delete all snapshots on the volume (ensure
that you have a valid backup on hand) using the PSM GUI. PSM allows
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defragmentation of the volume; however, the PSM Cache files still remain
fragmented, and you will not be able to create snapshots. To enable snapshots, you
must delete the PSM Cache files on the defragmented volume. PSM automatically
rebuilds them.

Attention: NEVER delete or alter the PSM Cache files or directory on a volume
that still has snapshots.

Cache Deletion Procedure:

1. Open Windows Explorer and click the defragmented volume under “My
Computer” so that the top-level contents of the volume are displayed in the right
pane. Click Windows Explorer→Tools→Folder Options. Select the View tab.
Ensure that Show Hidden Files and Folders is selected, and that Hide
protected operating system files is not selected. Click OK to close and apply
the Folder Options settings.

2. Press the F5 function key to Refresh the top-directory volume contents. You
should see a folder named “Persistent Storage Manager State.” Right-click the
directory and select Properties. Select the Security tab. Select Administrators
in the Name field. Ensure that Full Control is selected in the permissions field;
the other permissions should automatically become selected. Click OK to save
the security settings and close.

3. Right-click the folder named “Persistent Storage Manager State” again, and
select Delete. Click Yes at the pop-up warning. Then, right-click the Recycle Bin
icon and select Empty Recycle Bin to complete the deletion of the PSM Cache
directory and contents.

PSM should be now able to take snapshots again. Creating the first snapshot will
take a little longer as PSM rebuilds the cache file.

Known issues
1. If a re-extended volume (containing True Images of the pre-extended volume) is

reverted, the re-extended area of the disk is unusable. To reclaim this space,
executed the ″reextend.exe″ utility after reverting from a True Image of the
pre-extended volume. This utility is available in the directory:
“c:\winnt\system32\serverappliance”. Use this utility by typing “reextend -?”.

2. The event log error “a driver below this one has failed in some way for” may
occur when the cache file is full.

3. If all your Persistent True Images on “C:\” are tagged as Always Keep, and the
cache file fills up, the system might experience a BSOD at reboot. It is not
recommended to flag all Persistent True Images as Always Keep because this
disallows the deletion logic of PSM to delete the older Persistent True Images to
free up cache file space.

4. Default cache setting is not displayed correctly. For example, if you set the
cache file % at the Volume setup page to 2% and then take a Persistent True
Image, the value grays out and is not selectable. If you then select restore
default settings, the cache file appears to change to 20%, and you click OK.
When you return to that page, the screen would show 2%, not 20%. To avoid
this problem, you must delete Persistent True Images before increasing the
Cache size.

5. In certain cases where the IBM NAS is under load, Persistent Storage Manager
might fail to automatically delete the last snapshot on a volume when the cache
file fills up. The volume typically has one snapshot outstanding when the cache
file exceeds the deletion threshold. At this point, if the system is experiencing
heavy file system load, the write volume prevents PSM from successfully
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deleting the last snapshot before the cache reaches 100%. At this point, the last
snapshot must be deleted manually to return to normal operation. The cache file
should then show 0% utilization through the PSM interface (if not, try restarting
the Terminal Services client by closing the window and reopening it) and PSM
operation should proceed normally. If the issue remains or the cache does not
go to 0% utilization, call IBM service.

Limitations
1. Only NTFS volumes are supported by PSM.

2. The Page file size must not change and the initial size must be set equal to the
maximum size. This setting is located in the Virtual Memory settings under
System Properties.

3. If the system cannot boot, the revert ability cannot be performed.

4. PSM automatically disables the ability to revert the system boot drive.

5. Microsoft confirmed that the NFS Services for UNIX does not support volume
mount points. The NFS clients cannot access data on volumes mounted using a
volume mount point. Although Persistent True Images for a volume are shared
using NFS, the NFS clients cannot access the Persistent True Image data
because Persistent True Images for a volume are mounted as directory
junctions (mount points). Refer to Release Notes for Microsoft Server Appliance
Kit dated June 2001.

Operating system shows two physical CPUs as four CPUs
The NAS Gateway 300 incorporates the latest Intel Xeon processors, which use a
new technology called Hyperthreading. Hyperthreading allows one physical CPU to
run multiple threads simultaneously, as if it were two CPUs. Because of this, each
physical processor looks like two logical processors to the operating system. This
can be confusing when observing that the BIOS reports that the system has two
CPUs, and Windows reports that the system has four CPUs.

UPS service error
On the Status of the Windows 2000 for NAS GUI, you will see that the UPS service
has been stopped.

Note: This is the default state of this service on the NAS GUI. In addition, the
“Uninterruptible Power Supply” must be set to Manual in the Control
Panel→Administrative Tools→Services. UPS Service must be enabled
before you can use your uninterruptible power supply device. Do not enable
the UPS Service unless you have an uninterruptible power supply device
attached to your appliance.

The process to correctly configure and enable the UPS Service using the Windows
2000 for NAS GUI follows:

1. Attach your customer-provided RS-232 cable from your uninterruptible-power-
supply hardware to an available COM Port on your NAS appliance.

2. To set “Uninterruptible Power Supply” Control Panel Service to “Automatic” and
“Start”:

a. Log in to the NAS appliance through the Terminal Services Client.

b. Click My Computer→Control Panel→Administrative Tools→Services and
highlight “Uninterruptible Power Supply” service.

c. Right-click Service, go to Properties, and then set Services to “Automatic.”

d. Click Apply; then, to start the service, click Start.
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3. To configure uninterruptible-power-supply connections and enable service using
Windows 2000 for NAS GUI:

a. Click Maintenance → UPS.

b. Select the manufacturer, model, and COM port to which your uninterruptible
power supply device is attached.

c. Select the Enable the UPS service on this appliance check box and click
OK.

Administration notes
This section contains administration information.

NAS Setup Navigator
Version 2.7 of the Model G02 includes the NAS Setup Navigator configuration tool.
The NAS Setup Navigator maps out the initial configuration tasks and leads you
through the tasks in the proper order. The tool detects which NAS appliance it is
running on and adjusts the menu and content appropriately. You can follow links to
more in-depth information and to the configuration panels used to perform the
steps. You can also tailor the instructions to fit your needs by selecting optional
topics. To start the NAS Setup Navigator, click the NAS Setup Navigator icon on the
desktop.

NAS Admin tool
If users other than the local machine Administrator have administrative privileges
and will need to use the NAS Admin tool, this file must be copied to that user’s
Desktop folder. Example:
copy "c:\Documents and Settings\Administrator\Desktop\IBM NAS Admin.msc"
"c:\Documents and Settings\<user name>\Desktop"

IBM Director
NAS Version 2.7 includes the IBM Director 3.1.1 agent in the preloaded software.
The 3.1.1 designation means that the IBM Director 3.1 agent is installed as well as
the IBM Director 3.1 Service Pack 1. If you intend to use the IBM Director Server to
manage your NAS product, ensure that your IBM Director Server and Console are
at the 3.1 version; you must also install the IBM Director 3.1 Service Pack 1 on
your IBM Director Server and Consoles.

For more information about obtaining the IBM Director 3.1 Service Pack 1 for your
IBM Director Server and Consoles, visit www.ibm.com/pc/support and click
Systems Management.

Supplementary CD 1 contains NAS-specific extensions to the IBM Director Server
to assist you in managing NAS appliances using the IBM Director Server. These
extensions are identified as “IBM NAS Extensions for IBM Director”. One of the
features within these extensions creates an ‘IBM NAS Appliances’ group on the IBM
Director Console which enables you to manage NAS appliances as a group, but the
version of these extensions on the CD might not include the most current NAS
products. For the latest version of the IBM NAS-specific extensions to the IBM
Director Server, visit www.ibm.com/storage/support/nas.

The section titled “Rack Manager and inventory enhancements” in the IBM
TotalStorage NAS Gateway 300 Model G27 User’s Reference describes
enhancements to recognize IBM NAS components in the Rack Manager Task of the
IBM Director Server and indicated that these enhancements were available through
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the application of the IBM Director Server 3.1 Service Pack 1. These enhancements
are not available in the IBM Director Server 3.1 Service Pack 1, but will be made
available in a future IBM Director deliverable. For more information about IBM
Director deliverables, visit www.ibm.com/pc/support and click the link for Systems
Management.

Uninterruptible power supply support
Release 2.7 includes support for uninterruptible power supplies. Uninterruptible
power supply devices provide emergency backup power for a specific period of time
when the local power fails. This power comes from batteries housed within the
device. High-performance surge suppression helps protect your appliance from
electrical noise and damaging power surges. During a power failure, the
uninterruptible power supply is designed to instantly switch your appliance to
emergency battery backup power. After you have installed an uninterruptible power
supply for your appliance, you can set options for its operation using the UPS Task
on the Maintenance page. The UPS Task enables you to control how the
uninterruptible power supply service works on your appliance. The available UPS
Settings depend on the specific uninterruptible power supply hardware installed on
your system. Before you use your uninterruptible power supply device, type the
following information on the UPS Configuration page:

v Uninterruptible power supply device manufacturer

v Uninterruptible power supply device model

v The serial port to which the uninterruptible power supply device is connected

To configure the uninterruptible power supply service, see “UPS service error” on
page 27.

To help protect your appliance from power failures, test it by simulating a power
failure by disconnecting the main power supply from the uninterruptible power
supply device. Do not perform this test during production use. Your appliance and
peripherals connected to the uninterruptible power supply device should remain
operational, messages should be displayed, and events should be logged. Wait until
the uninterruptible power supply battery reaches a low level to ensure a correct
shutdown occurs. Restore the main power to the uninterruptible power supply
device, and check the event log to verify that all actions were logged and there
were no errors. All detected power fluctuations and power failures are recorded in
the event log, along with uninterruptible power supply service start failures and
appliance shutdown initiations. Critical events might change the status of the
appliance.

Configuring LAN-free backup when using TSM Server v4.2.2
The NAS 300 Model G02 is preloaded with TSM Client, TSM Agent and TSM Driver
Version 4.2.2. When also using TSM Server Version 4.2.2 on a separate server,
configuring the Model G02 to use LAN-free backup to a tape library can be difficult.
To ease this configuration, a TSM macro file is supplied on the Supplementary CD
as file: “\tsm_scripts\tsm_lan_free.mac”. The file contains instructions for using it
during the configuration process.

Configuring page files for optimization
NAS appliances are based on a Windows Powered Operating System and have a
default pagefile of 1024 MB that is located on the boot system drive “C:”. This
default size is based on a minimum base memory configuration for all IBM
TotalStorage appliances and preloaded software. Memory options can vary on each
appliance depending on what you have ordered.
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By default, Windows Powered places the pagefile on the boot partition where the
operating system is installed. The pagefile is not a shared disk, but a local disk for
the clustered systems. To determine the size of the pagefile, multiply the amount of
physical RAM by 1.5 to a maximum of 4095 MB. Be aware that placing the pagefile
on the boot partition does not optimize performance because Windows has to
perform disk I/O on both the system directory and the pagefile. Therefore, it is
recommended that you place the pagefile on a different partition (such as the
maintenance partition) or a different physical hard disk drive, so that Windows
Powered can handle multiple I/O requests more quickly. It is highly recommended
that on the NAS appliances, you increase the pagefile by adding to the
maintenance partition. The size will vary depending on the physical memory
installed on the appliance. You can check memory by right-clicking My
Computer→properties. This opens a System Properties window, and the memory
will be displayed. This can be performed through Terminal Services or by
connecting a monitor, keyboard, and mouse to the appliance.

Note: Do not remove the pagefile from the boot partition. If the pagefile is not on
the boot partition, the operating system cannot create a crash dump file
(Memory.dmp) in the event that a kernel mode STOP error occurs. Not
having this crash dump file could lead to extended server downtime if the
STOP requires a debug operation to be performed.

The optimal solution is to create one pagefile on the boot partition using the default
settings and create one pagefile on another, less frequently used partition. The best
option is to create the second pagefile so that it is on its own partition (such as a
maintenance partition), with no data or operating system-specific files.

Windows Powered uses the pagefile on the less frequently used partition over the
pagefile on the heavily used boot partition. Windows Powered also uses an internal
algorithm to determine which pagefile to use for virtual memory management. In the
above scenario, the following goals of the page file are served:

v The system is correctly configured to capture a Memory.dmp file if the computer
experiences a kernel mode STOP error.

v The page file on the less frequently used partition is used the majority of the time
because it is not on a busy partition.

Another advantage of using a pagefile on its own partition is that the pagefile will
not become fragmented. If the pagefile is on a partition with other data, the pagefile
might experience fragmentation because it expands to satisfy the extra virtual
memory required. A defragmented pagefile leads to faster virtual memory access
and improves the chances of capturing a dump file without significant errors.

Microsoft® Windows blue screen possible when hot-swapping a hard
disk drive

On a NAS Gateway 300 using mirrored (RAID 1) disks, the hot swap of a disk drive
can cause a Windows blue screen when ServeRAID Manager is used to set a
mirrored drive’s state to “defunct” and then the drive is removed. If the drive’s state
is not explicitly set to “defunct” but instead fails or is removed directly, then the
Windows blue screen does not occur.

Checking Persistent Storage Manager version
The only reliable way to verify the version of PSM on your system is to execute the
following on a command prompt local to the NAS:
c:\winnt\system32\serverappliance\ss -version
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An example of the output from this command executed on a system with PSM
version 2261 + 2263 QFE installed is:

C:\WINNT\system32\ServerAppliance>ss -version
ss - Snapshot Command line management utility
Copyright (c) 2000-2002 Columbia Data Products, Inc. All Rights Reserved.

IBM version
LoVersion = 0x00000200
Version = 2.20 build 2262
Eval = no

Date/Time Version File
7/26/2002 12:19 2.20.00.2261 ’C:\WINNT\system32\ServerAppliance\psmlapi.dll’
8/13/2002 11:36 2.20.00.2263 ’C:\WINNT\system32\ServerAppliance\ss.exe’
7/26/2002 12:19 2.20.00.2261 ’C:\WINNT\System32\psmready.exe’
8/06/2002 6:18 2.20.00.2262 ’C:\WINNT\System32\drivers\psman5.sys’
7/26/2002 12:19 2.20.00.2261 ’C:\WINNT\System32\serverappliance\mui\0409\snapshot.dll’
7/26/2002 12:19 2.20.00.2261 ’C:\WINNT\System32\serverappliance\PSMCom.dll’
7/26/2002 12:19 2.20.00.2261 ’C:\WINNT\System32\serverappliance\drbackup.dll’

Updated information on Supplementary CDs
This information replaces the information in the section titled “Using the
Supplementary CD” in Chapter 10 of the IBM TotalStorage NAS Gateway 300
Model G27 User’s Reference.

The Supplementary CDs contain documentation and copies of key software
applications that are preinstalled on the NAS Gateway 300. Table 3 and Table 4 on
page 32 include the names of the directories found on the Supplementary CDs and
a description of the contents of each directory.

Table 3. Supplementary CD 1 directories

Directory name Contents

DB2®
v EnableDB2Support.exe
v DisableDB2Support.exe

These files enable and disable support for Linux- and Solaris-based DB2 clients using
NFS shares.

DiskImages This directory contains a diskette image for the Recovery Enablement Diskette and a
diskette image for a bootable diskette that automatically configures the ServeRAID
controller and drives.

To create the Recovery Enablement Diskette, run enablement_diskette291.EXE and
insert an HD 1.44 floppy diskette into drive A: when prompted.

To create the bootable diskette to automatically configure the ServeRAID controller and
drives, run IBM_NAS_AutoRAID_diskette_2.9.EXE and insert a HD 1.44 floppy diskette
into drive A: when prompted.

diskpart Samples This directory contains an example script for use with the DiskPart utility. This script will
clean disk 2, convert it to dynamic, partition it, and assign drive letters to the partitions.
This script is unsupported and should be used with extreme caution.

IBM Advanced Appliance
Configuration

Run Setup.exe on the machine from which you will administer the appliance. The agent
is preinstalled on the appliance.

IBM NAS Extensions For
IBM Director

The IBM NAS extensions to IBM Director provide capabilities to IBM Director that are
specific to the IBM NAS appliances.

Zip Tools This directory contains compression tools used for sending information to IBM technical
support.

readme.txt This text file describes the contents of the Supplementary CDs.
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Table 4. Supplementary CD 2 directories

Directory name Contents

AoP This is the add-on pack for the Server Appliance Kit.

SFU_2073.1 Microsoft Services for UNIX (SFU) Version 2.2 support files:
v QFE 320175 for performance enhancements
v QFE 321096 for SAK and SFU performance enhancements

readme_SFN5.txt Instructions for installing Microsoft File and Print Services for NetWare 5.0.

Terminal Services Client Microsoft Terminal Services Client installation files.

w2ksp2 Windows 2000 Service Pack 2.

Fibre Channel adapter event logs
You can view event logging for the Fibre Channel adapter for troubleshooting
problems using the event viewer. The detailed event code is displayed at offset 34
(hex). Table 5 gives a list of detailed event codes for the adapter. For some of the
event codes, additional data will be recorded in the least significant 16 bits of the
longword. Additional data might also be recorded in the longword at offset 10 (hex).

Certain codes will be logged only if you set a Fast!UTIL parameter to enable
additional event logging. These codes are indicated by an asterisk (*). By default,
these events are not logged.

If an error occurs that is not listed in Table 5, contact the IBM Support Center (1
800 426-7378 in the U.S.). In all other countries, contact your IBM reseller or IBM
marketing representative.

Table 5. Fibre Channel adapter error codes

Event code offset
34h

More data offset
10h

Description Suggested action

4002xxxx yyyy00zz Host interface error: xxxx = mailbox1; yyyy =
mailbox2; zz = command

Hardware DMA error:
replace adapter

4005xxxx Yyyy00zz Mailbox command error: xxxx = mailbox1; yyyy
= mailbox2; zz = command

Normally indicates loop
down, check all cabling

4005xx6F yyyyyyzz Login Fabric port mailbox command error: xx =
adapter; state yyyyyy = port id; zz = loop id

Normally indicates loop
down, check all cabling

* 80010000 00000000 Reset detected Not logged during normal
operation

8003xxxx yyyyzzzz RISC request queue transfer error: xxxx =
mailbox1; yyyy = mailbox2; zzzz = mailbox3

Hardware error: replace
adapter

8004xxxx yyyyzzzz RISC response queue transfer error: xxxx =
mailbox1; yyyy = mailbox2; zzzz = mailbox3

Hardware error: replace
adapter

* 80100000 0000xxxx LIP occurred: xxxx = mailbox1 Not logged during normal
operation

* 80110000 xxxxyyzz Link up 2200: xxxx = current ISP connection
mode (0 = Loop, 1 = P2P); yy = ISP
connection option 0 = Loop, 1 = P2P, 2 =
Loop->P2P, 3 = P2P->Loop; zz = starting loop
ID for remote devices. 2100: xxxx = 0000; yyyy
= 0000

Not logged during normal
operation

80120000 00000000 Link down error Not logged during normal
operation
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Table 5. Fibre Channel adapter error codes (continued)

Event code offset
34h

More data offset
10h

Description Suggested action

80130000 0000xxxx LIP reset occurred: xxxx = mailbox1 Not logged during normal
operation

**80300000 xxxxyyzz Link mode up: xxxx = current ISP connection
mode 0 = Loop 1 = P2P; yy = ISP connection
option (0 = Loop, 1 = P2P 2 = Loop->P2P 3 =
P2P->Loop); zz = starting loop ID for remote
devices

Not logged during normal
operation

**8036aabb xxxxyyzz Point-to-Point update configuration: xxxx =
mailbox1; yy = current ISP connection mode (0
= Loop, 1 = P2P); zz = ISP connection option
0 = Loop, 1 = P2P, 2 = Loop->P2P, 3 =
P2P->Loop; aa = starting loop ID value for
remote devices; bb = current retry count for the
ISP initialization mode

Not logged during normal
operation

* F0000000 00000000 Restarting RISC firmware Initial driver load or loop
down longer than 4
minutes

* F0030004 00xx00yy Reset command completion error: xx = CDB
opcode; yy = target loop ID

Not logged during normal
operation

* F0030005 00xx00yy Command aborted by OS: xx = CDB opcode;
yy = target loop ID

Not logged during normal
operation

F0030028 00xx00yy Port unavailable, command completion error:
xx = CDB; opcode yy = target loop ID

Check target device and
cabling

F0030029 00xx00yy Port logged out command completion error: xx
= CDB; opcode yy = target loop ID

Check target device and
cabling

F003001C 00xx00yy Target device queue full (SCSI status 28 from
target): xx = CDB opcode; yy = target loop ID

Check target device and
cabling

* F00A0000 0000xxxx RISC firmware state during adapter
initialization: xxxx = firmware state

Not logged during normal
operation

F00B0000 00000000 Reset ISP chip failed

F00D0000 00000000 Fail to allocate noncached memory

F00E0000 00000000 Fail to map ISP registers

F00F0000 00000000 Fail to load RISC code

F0100000 0000xxxx Fail to start RISC code: xxxx = mailbox0

F0110000 0000xxxx Fail to initialize firmware xxxx = mailbox0

F0120000 0000xxxx Fail to get firmware state: xxxx = mailbox0

* F0130000 00000000 Port Update notification (RISC database
changed)

* F0140000 xxxxxxxx RSCN notification (Name server change
detected): xxxx = RSCN Information

* F0150000 00xx00yy Name server query rejected (v6 2100): xx =
Reason Code; yy = Explanation Code (Valid if
reason code is 0x09)
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Table 5. Fibre Channel adapter error codes (continued)

Event code offset
34h

More data offset
10h

Description Suggested action

* F0150000 xxxxyyzz Name server query rejected (v7 2100/2200):
xxxx = response status; yy = Reason Code; zz
= Explanation Code (Valid if reason code is
0x09, for example, if zz = 0x09, yy = 07, this
means no SCSI device found.)

* F0160000 00000000 Driver reset called; command timed out

* F0170000 00xxxxxx Fabric port login (for information only): xxxxxx
= Port ID

F0180000 000000xx Excessive link errors, loop down: xx = number
of link errors per second

* F0190000 00000000 Verify firmware checksum failure

* F01B0000 000000xx Device marked offline after being not-ready
longer than port down retry count: xx = loop ID
of device

* F01C0000 000000xx Bad type field in IOCB from RISC: xx = IOCB
type

* F01D0000 00000000 Error downloading post RISC code

* F01Exxxx Yyyyzzzz Error running post RISC code: xxxx =
mailbox0; Yyyy = mailbox1; zzzz = mailbox2

* F01Fxxyy Zzzzzzzz DMA 64 bit (PAE) configuration (for information
only): xx = Dma64BitAddressess flag set by
W2K; yy = Dma64BitAddressess flag set by
driver; zzzzzzzz = driver adapter flags

F0200000 Xxxxyyyy Error ISP not accessible: xxxx = ISP host
command and control; yyyy = ISP interrupt
status

* F0210000 xxyy00zz ISP connection option/topology (for information
only): xx = ISP connection option from
NVRAM; yy = previous ISP topology; zz =
current ISP topology code: 0000 = Loop, 0001
= FL_Port, 0002 = N_Port to N_Port, 0003 =
F_Port

* F0220000 0000xxxx External RISC ram parity error (for 2200G
only): xxxx = number of parity errors detected

* F0230000 Xxxxyyyy Subvendor ID not match (for information only):
xxxx = actual subvendor ID; yyyy = expected
subvendor ID

Persistent Storage Manager event log messages
If you experience problems while using the Persistent Storage Manager to create,
schedule, or delete persistent images, or while using the NAS Backup Assistant /
IBMSNAP.EXE to perform a Persistent Image backup, use the Table 6 on page 35
to troubleshoot any problems. Each of these messages are logged to the system
event log by the PSMAN5 driver (file system driver for Persistent Storage Manager
[PSM]); each entry appears with “psman5” as the source name.

For more information about Persistent Storage Manager and persistent images, see
the IBM TotalStorage NAS Gateway 300 Model G27 User’s Reference.
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Table 6. Persistent Storage Manager event log messages

Error Code Description Action

0x00000001 An invalid IOCTL was sent to the driver. Contact IBM technical support.

0x00000002 Device name is not recognized by PSM. Contact IBM technical support.

0x00000003 An invalid path was given for the cache file.
This error will appear if the cache file cannot
be created because the cache file drive is not
present.

Contact IBM technical support.

0x00000005 An exception occurred. Contact IBM technical support.

0x00000005 You do not have sufficient rights to the cache
file directory.

Contact IBM technical support.

0x00000005 The cache file specified is a directory instead
of a file.

Contact IBM technical support.

0x00000005 PSM was told to shut down. Contact IBM technical support.

0x00000006 User performing PSM function without
opening PSM.

Contact IBM technical support.

0x00000015 Access to a virtual volume has been
attempted after the virtual volume has been
destroyed.

Do not access virtual volumes after they
have been destroyed.

0x00000016 Something has gone wrong with PSM. Contact IBM technical support.

0x00000017 Bad sector was detected in the cache file. Contact IBM technical support.

0x0000001F General failure. Contact IBM technical support.

0x00000057 An invalid parameter was passed to a
function.

Contact IBM technical support.

0x00000079 I/O timed out while reading from the cache
file.

Contact IBM technical support.

0x0000007A Buffer size supplied is insufficient to hold
requested information.

Contact IBM technical support.

0x000000A1 An invalid path was given for the cache file. Contact IBM technical support.

0x000000EA Buffer size supplied is insufficient to hold
requested information.

Contact IBM technical support.

0x000003E6 An exception occurred. Contact IBM technical support.

0x00000456 PSM was stopped because the media of a
device was changed on which PSM was
running.

Contact IBM technical support.

0x0000045D An error occurred on the device. Contact IBM technical support.

0x000005AA There is insufficient memory available. Contact IBM technical support.

0x000006F8 Buffer size supplied is insufficient to hold
requested information.

Contact IBM technical support.

0x000006F8 Invalid buffer address passed for I/O. Contact IBM technical support.

0x80000005 Specified buffer size is too low. Contact IBM technical support.

0x8000001C PSM was stopped because the media of a
device was changed on which PSM was
running.

Take a new persistent image.
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Table 6. Persistent Storage Manager event log messages (continued)

Error Code Description Action

0xA0000004 The cache file is <x>% full. The oldest
persistent images will automatically be deleted
at <y>%.

This is a warning that the cache file size is
approaching the threshold at which some
persistent images will be deleted automatically
to free up some cache file capacity. <x> is the
percentage for which the warning message
will be generated, and <y> is the percentage
that represents the threshold. (By default,
these values are 80% and 90%, respectively,
and can be modified in Windows 2000 for
NAS [Disks/Persistent Storage Manager]).

In Windows 2000 for NAS
(Disks/Persistent Storage Manager), delete
some (noncritical) persistent images before
the system does to guarantee that critical
persistent images do not get deleted
accidentally.

0xC0000001 General failure. Contact IBM technical support.

0xC0000002 Function is not yet implemented. Contact IBM technical support.

0xC0000005 An Access Exception occurred. Contact IBM technical support.

0xC0000008 User performing PSM function without
opening PSM.

Contact IBM technical support.

0xC000000D An invalid parameter was passed to a
function.

Contact IBM technical support.

0xC000000E Device name is not recognized by PSM. Contact IBM technical support.

0xC0000010 An invalid IOCTL was sent to the driver. Contact IBM technical support.

0xC0000013 Access to a virtual volume has been
attempted after it has been destroyed.

Contact IBM technical support.

0xC000001C An invalid IOCTL was sent to the driver. Contact IBM technical support.

0xC0000022 An access exception occurred. Contact IBM technical support.

0xC0000022 You do not have sufficient rights to the cache
file directory.

Contact IBM technical support.

0xC0000023 Specified buffer size is too small. Contact IBM technical support.

0xC0000034 Cache file name is invalid. Contact IBM technical support.

0xC000003A An invalid path was given for the cache file. Contact IBM technical support.

0xC000003B An invalid path was given for the cache file. Contact IBM technical support.

0xC000003E Bad sector was detected in the cache file. Contact IBM technical support.

0xC0000043 A file cannot be opened because the share
access flags are incompatible.

This occurs when the very last persistent
image is deleted. PSM initializes its files
when the last persistent image is deleted.
While it is initializing, a new persistent
image can not be created. Try again in a
few minutes.

0xC000009A There is insufficient memory available. Contact IBM technical support.

0xC00000B5 I/O timed out while reading from the cache
file.

Contact IBM technical support.

0xC00000BA The cache location must be a file rather than
a directory.

Contact IBM technical support.

0xC00000E8 Invalid buffer address passed for I/O. Contact IBM technical support.

0xC000010A PSM was told to shut down. Contact IBM technical support.
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Table 6. Persistent Storage Manager event log messages (continued)

Error Code Description Action

0xC0000184 Something has gone wrong with PSM. Contact IBM technical support.

0xC0000185 An error occurred on the device. Contact IBM technical support.

0xC0000206 Buffer size supplied is insufficient to hold
requested information.

Contact IBM technical support.

0xE0001001 PSM could not start due to the server being
constantly busy for <x> minutes.

Take a persistent image when NAS
appliance demands are lower.

0xE0001002 PSM detected a deadlock. Contact IBM technical support.

0xE0001003 Specified volume not active or deleted. Do not delete volumes with active
persistent images.

0xE0001004 PSM was specified for a volume on which
PSM is not running.

Contact IBM technical support.

0xE0001005 Cache file overflow caused all existing
persistent images to be deleted.

Increase the cache file size in Windows
2000 for NAS (Disks/Persistent Storage
Manager), or take or schedule persistent
images when fewer users are online.

0xE0001006 The application tried to enable PSM without
first calling PSM_Register.

Contact IBM technical support.

0xE0001007 Invalid license code. Contact IBM technical support.

0xE0001008 Another application already has PSMed
locked exclusively.

Contact IBM technical support.

0xE0001009 PSM needs to be locked exclusive for this
function to work.

Contact IBM technical support.

0xE000100A Wrong version of the driver has been loaded
on this system.

Contact IBM technical support.

0xE000100B A reboot is required before PSM can operate. Reboot the appliance, and try taking a
persistent image again. If this still fails,
contact IBM technical support.

0xE000100C PSM is not installed. Contact IBM technical support.

0xE000100D An incompatible DLL from another version of
PSM is already loaded.

Contact IBM technical support.

0xE000100E Out of memory. Contact IBM technical support.

0xE000100F Invalid parameter. Contact IBM technical support.

0xE0001010 Invalid handle. Contact IBM technical support.

0xE0001011 Not implemented yet. Contact IBM technical support.

0xE0001012 Object type is not expected object. Contact IBM technical support.

0xE0001013 User buffer is not large enough. Contact IBM technical support.

0xE0001014 Out of available structures. In Windows 2000 for NAS
(Disks/Persistent Storage Manager), delete
some persistent images.

0xE0001015 PSM is shutting down. Contact IBM technical support.

0xE0001016 The device, volume or object does not exist. Contact IBM technical support.

0xE0001017 Unsuccessful. Contact IBM technical support.

0xE0001018 The device does not have any media loaded. Contact IBM technical support.

0xE0001019 Object already exists. Contact IBM technical support.

0xE000101A Specified path is a directory and not a file. Contact IBM technical support.
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Table 6. Persistent Storage Manager event log messages (continued)

Error Code Description Action

0xE000101B Invalid path was specified. Contact IBM technical support.

0xE000101C The static volume was not mounted. Look at the system event log for a warning
message (from the PSMAN5 service)
whose code should appear in this list. The
action depends on the message.

0xE000101D The static volume had errors during mount. Look at the system event log for a warning
message (from the PSMAN5 service)
whose code should appear in this list. The
action depends on the message.

0xE000101E The static volume could not be found. Contact IBM technical support.

0xE000101F The volume the cache file resides on is out of
space.

The cache file for each volume resides on
the volume itself. Free some space on the
volume.

0xE0001020 The volume the cache file resides on was
dismounted.

The cache file for each volume resides on
the volume itself. Do not dismount the
volume.

0xE0001021 The server was shut down. Do not shut down the IBM TotalStorage
NAS appliance while persistent images are
in progress.

0xE0001022 Unable to create cache file. Contact IBM technical support.

0xE0001023 PSM recovery could not find a persistent
image entry.

A persistent image was lost during the
recovery process. It is unknown which
persistent image it was.

Contact IBM technical support.

0xE0001024 PSM recovery could not open the index file.
All persistent images are corrupt.

Contact IBM technical support.

0xE0001025 PSM recovery encountered error <x>inserting
key (<y>:<z>) into dictionary.

<x> is the error that occurred and can be
found in this list of errors.

Look up the error in this list and take the
specified action.

0xE0001026 PSM recovery encountered corrupt index
sector %2.

An index entry was found to be corrupt during
the last boot.

Contact IBM technical support.

0xE0001027 A persistent image could not be created due
to error 0x<x>.

<x> is the error that occurred.

Look up the error in this list and take the
specified action.

0xE0001028 The cache file is <x>% full. Persistent images
have been deleted.

The oldest persistent images have been
deleted.

In Windows 2000 for NAS
(Disks/Persistent Storage Manager), delete
persistent images to make sure specific
(critical) persistent images are not
destroyed by mistake.
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Table 6. Persistent Storage Manager event log messages (continued)

Error Code Description Action

0xE0001029 The maximum (<x>) allowed persistent
images has been reached. A persistent image
was not created.

PSM cannot create any more persistent
images because the configured maximum
number of persistent images that PSM can
keep concurrently has been reached.

In Windows 2000 for NAS
(Disks/Persistent Storage Manager)
increase the number of persistent images
allowed, or edit the schedules to not make
so many persistent images.
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Appendix B. Notices

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering the subject matter in
this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country
where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS
MACHINES CORPORATION PROVIDES THIS PUBLICATION ″AS IS″ WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. Some states
do not allow disclaimer of express or implied warranties in certain transactions,
therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or program(s) described in this publication at any
time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.
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End of Life (EOL) statement
This box is a purchased unit. Therefore, it is the sole responsibility of the purchaser
to dispose of it in accordance with local laws and regulations at the time of
disposal.

This unit contains recyclable materials. The materials should be recycled where
facilities are available and according to local regulations. In some areas IBM may
provide a product take-back program that ensures proper handling of the product.
Contact your IBM representative for more information.

Trademarks
The following items are trademarks of the IBM Corporation in the United States or
other countries or both:

IBM the IBM logo ServeRAID DB2
TotalStorage IBM Director SANergy Tivoli
Tivoli Enterprise NetView

Alacritech and SLIC Technology are registered trademarks of Alacritech, Inc. in the
United States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks or registered trademarks of
Microsoft Corporation.

Persistent Storage Manager is a trademark of Columbia Data Products, Inc.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in
the United States, other countries, or both.

UNIX is a registered trademark in the United States, other countries, or both, and is
licensed exclusively through X/Open Company Ltd.

Other company, product, and service names may be trademarks or service marks
of others.
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Appendix C. Safety notices

The following sections describe the safety and environmental items you must
consider for an IBM NAS Appliance.

Basic safety information

DANGER

Before you begin to install this product, read the safety information in
Caution: Safety Information–Read This First, SD21-0030. This booklet
describes safe procedures for cabling and plugging in electrical equipment.

Gevarr: Voodrat u begint met de installatie van dit produkt, moet u eerst
de veiligheidsinstructies lezen in de brochure PAS OP! Veiligheidsinstructies–Lees
dit eerst, SD21-0030. Hierin wordt beschreven hoe u electrische apparatuur op een
veilige manier moet bekabelen en aansluiten

Danger: Avant de procéder à l’nstallation de ce produit, lisez d’abord les
consignes de sécurité dans la brochure ATTENTION: Consignes de sécurité–A lire
au préalable, SD21-0030. Cette brochure décrit les procédures pour câbler et
connecter les appareils électriques en toute sécurité.

Perigo: Antes de começar a instaler deste produto, leia as informações
de segurança contidas em Cuidado: Informações Sobre Segurança–Leia Primeiro,
SD21-0030. Esse folheto descreve procedimentos de segurança para a instalação
de cabos e conexões em equipamentos elétricos.
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Fare! Før du installerer dette produkt, skal du læse
sikkerhedsforskrifterne i NB: Sikkerhedsforskrifter – Læs dette først SD21-0030.
Vejledningen beskriver den fremgangsmåde, du skal bruge ved tilslutning af kabler
og udstyr.

Gevarr: Voordat u begint met het installeren van dit produkt, dient u eerst
de veiligheidsrichtlijnen te lezen die zijn vermeld in de publikatie Caution: Safety
Information - Read This First, SD21-0030. In dit boekje vindt u veilige procedures
voor het aansluiten van elektrische appratuur.

VARRA: Ennen kuin aloitat tämän tuotteen asennuksen, lue julkaisussa
Varoitus: Turvaohjeet–Lue tämä ensin, SD21-0030, olevat turvaohjeet. Tässä
kirjasessa on ohjeet siitä, mitensähkölaitteet kaapeloidaan ja kytketään turvallisesti.

Danger : Avant d’installer le présent produit, consultez le livret Attention :
Informations pour la sécurité–Lisez-moi d’abord, SD21-0030, qui décrit les
procédures à respecter pour effectuer les opérations de câblage et brancher les
équipments électriques en toute sécurité.

Vorsicht: Bevor mit der Installation des Produktes begonnen wird, die
Sicherheitshinweise in Achtung: Sicherheitsinformationen–Bitte zuerst lesen. IBM
Form SD21-0030. Diese Veröffentilchung beschreibt die Sicherheitsvorkehrungen
für das Verkabien und Anschließen elektrischer Geräte.
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Vigyázat: Mielôtt megkezdi a berendezés üzembe helyezését, olvassa el
a Caution: Safety Information–Read This First, SD21-0030 könyvecskében leírt
biztonsági információkat. Ez a könyv leírja, miyen biztonsági intézkedéseket kell
megtenni az elektromos berendezés huzalozásakor illetve csatlakoztatásakor.

Pericolo: prima di iniziare l’installazione di questo prodotto, leggere le
informazioni relatie alla sicurezza riportate nell’opuscolo Attenzione: Informazioni di
sicurezza–Prime informazioni da leggere in cui sono descritte le procedure per il
cablaggio ed il collegamento di apparecchiature elettriche.
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Fare: Før du begynner å installere dette produktet, må du lese
sikkerhetsinformasjonen i Advarsel: Sikkerhetsinformasjon – Les dette forst,
SD21-0030 som beskriver sikkerhetsrutinene for kabling og tilkobling av elektrisk
utstyr.

Perigo: Antes de iniciar a instalação deste produto, leia as informações
de segurança Cuidado: Informações de Segurança–Leia Primeiro, SD21-0030. Este
documento descreve como efectuar, de um modo seguro, as ligações eléctricas
dos equipamentos.
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Peligro: Antes de empezar a instalar este producto, lea la información de
seguridad en Atención: Información de Seguridad–Lea Esto Primero, SD21-0030.
Este documento describe los procedimientos de seguridad para cablear y enchufar
equipos eléctricos.

Varning — livsfara: Innan du börjar installera den här produkten bör du
läsa säkerhetsinformationen i dokumentet Varning: Säkerhetsforeskrifter – Läs detta
först, SD21-0030. Där beskrivs hur du på ett säkert satt ansluter elektrisk
utrustning.

General safety
Follow these rules to ensure general safety:

v Observe good housekeeping in the area of the machines during and after
maintenance.

v When lifting any heavy object:
1. Ensure you can stand safely without slipping.
2. Distribute the weight of the object equally between your feet.
3. Use a slow lifting force. Never move suddenly or twist when you attempt to

lift.
4. Lift by standing or by pushing up with your leg muscles; this action removes

the strain from the muscles in your back. Do not attempt to lift any objects
that weigh more than 16 kg (35 lb.) or objects that you think are too heavy for
you.

v Do not perform any action that causes hazards to the customer, or that makes
the equipment unsafe.

v Before you start the machine, ensure that other service representatives and the
customer’s personnel are not in a hazardous position.

v Place removed covers and other parts in a safe place, away from all personnel,
while you are servicing the machine.

v Keep your tool case away from walk areas so that other people will not trip over
it.

v Do not wear loose clothing that can be trapped in the moving parts of a machine.
Ensure that your sleeves are fastened or rolled up above your elbows. If your
hair is long, fasten it.

v Insert the ends of your necktie or scarf inside clothing or fasten it with a
nonconductive clip, approximately 8 centimeters (3 inches) from the end.
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v Do not wear jewelry, chains, metal-frame eyeglasses, or metal fasteners for your
clothing.

Remember: Metal objects are good electrical conductors.

v Wear safety glasses when you are: hammering, drilling soldering, cutting wire,
attaching springs, using solvents, or working in any other conditions that might be
hazardous to your eyes.

v After service, reinstall all safety shields, guards, labels, and ground wires.
Replace any safety device that is worn or defective.

v Reinstall all covers correctly before returning the machine to the customer.

Electrical safety

Caution:
Electrical current from power, telephone, and communication cables can be
hazardous. To avoid personal injury or equipment damage, disconnect the
attached power cords, telecommunication systems, networks, and modems
before you open the appliance covers, unless instructed otherwise in the
installation and configuration procedures.

Observe the following rules when working on electrical equipment.

Important: Use only approved tools and test equipment. Some hand tools have
handles covered with a soft material that does not insulate you when
working with live electrical currents.

Many customers have, near their equipment, rubber floor mats that
contain small conductive fibers to decrease electrostatic discharges. Do
not use this type of mat to protect yourself from electrical shock.

v Find the room emergency power-off (EPO) switch, disconnecting switch, or
electrical outlet. If an electrical accident occurs, you can then operate the switch
or unplug the power cord quickly.

v Do not work alone under hazardous conditions or near equipment that has
hazardous voltages.

v Disconnect all power before:
– Performing a mechanical inspection
– Working near power supplies
– Removing or installing main units

v Before you start to work on the machine, unplug the power cord. If you cannot
unplug it, ask the customer to power-off the wall box that supplies power to the
machine and to lock the wall box in the off position.

v If you need to work on a machine that has exposed electrical circuits, observe
the following precautions:

– Ensure that another person, familiar with the power-off controls, is near you.

Remember: Another person must be there to switch off the power, if
necessary.

– Use only one hand when working with powered-on electrical equipment; keep
the other hand in your pocket or behind your back.

48 Model G02 Installation and Initial Setup Guide



Remember: There must be a complete circuit to cause electrical shock. By
observing the above rule, you may prevent a current from passing through
your body.

– When using testers, set the controls correctly and use the approved probe
leads and accessories for that tester.

– Stand on suitable rubber mats (obtained locally, if necessary) to insulate you
from grounds such as metal floor strips and machine frames.

Observe the special safety precautions when you work with very high voltages;
these instructions are in the safety sections of maintenance information. Use
extreme care when measuring high voltages.

v Regularly inspect and maintain your electrical hand tools for safe operational
condition.

v Do not use worn or broken tools and testers.

v Never assume that power has been disconnected from a circuit. First, check that
it has been powered-off.

v Always look carefully for possible hazards in your work area. Examples of these
hazards are moist floors, nongrounded power extension cables, power surges,
and missing safety grounds.

v Do not touch live electrical circuits with the reflective surface of a plastic dental
mirror. The surface is conductive; such touching can cause personal injury and
machine damage.

v Do not service the following parts with the power on when they are removed from
their normal operating places in a machine:
– Power supply units
– Pumps
– Blowers and fans
– Motor generators
– Similar units

This practice ensures correct grounding of the units.

v If an electrical accident occurs:
– Use caution; do not become a victim yourself.
– Switch off power.
– Send another person to get medical aid.
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Safety inspection guide
The intent of this inspection guide is to assist you in identifying potentially unsafe
conditions on these products. Each machine, as it was designed and built, had
required safety items installed to protect users and service personnel from injury.
This guide addresses only those items. However, good judgment should be used to
identify potential safety hazards due to attachment of non-IBM features or options
not covered by this inspection guide.

If any unsafe conditions are present, you must determine how serious the apparent
hazard could be and whether you can continue without first correcting the problem.

Consider these conditions and the safety hazards they present:
v Electrical hazards, especially primary power (primary voltage on the frame can

cause serious or fatal electrical shock).
v Explosive hazards, such as a damaged CRT face or bulging capacitor
v Mechanical hazards, such as loose or missing hardware

The guide consists of a series of steps presented in a checklist. Begin the checks
with the power off, and the power cord disconnected.

Checklist:

1. Check exterior covers for damage (loose, broken, or sharp edges).

2. Power-off the computer. Disconnect the power cord.

3. Check the power cord for:

a. A third-wire ground connector in good condition. Use a meter to measure
third-wire ground continuity for 0.1 ohm or less between the external ground
pin and frame ground.

b. The power cord should be the appropriate type as specified in the parts
listings.

c. Insulation must not be frayed or worn.

4. Remove the cover.

5. Check for any obvious non-IBM alterations. Use good judgment as to the safety
of any non-IBM alterations.

6. Check inside the unit for any obvious unsafe conditions, such as metal filings,
contamination, water or other liquids, or signs of fire or smoke damage.

7. Check for worn, frayed, or pinched cables.

8. Check that the power-supply cover fasteners (screws or rivets) have not been
removed or tampered with.
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Handling electrostatic discharge-sensitive devices
Any computer part containing transistors or integrated circuits (ICs) should be
considered sensitive to electrostatic discharge (ESD). ESD damage can occur when
there is a difference in charge between objects. Protect against ESD damage by
equalizing the charge so that the machine, the part, the work mat, and the person
handling the part are all at the same charge.

Notes:

1. Use product-specific ESD procedures when they exceed the requirements noted
here.

2. Make sure that the ESD protective devices you use have been certified (ISO
9000) as fully effective.

When handling ESD-sensitive parts:

v Keep the parts in protective packages until they are inserted into the product.

v Avoid contact with other people.

v Wear a grounded wrist strap against your skin to eliminate static on your body.

v Prevent the part from touching your clothing. Most clothing is insulative and
retains a charge even when you are wearing a wrist strap.

v Use the black side of a grounded work mat to provide a static-free work surface.
The mat is especially useful when handling ESD-sensitive devices.

v Select a grounding system, such as those listed below, to provide protection that
meets the specific service requirement.

Note: The use of a grounding system is desirable but not required to protect
against ESD damage.

– Attach the ESD ground clip to any frame ground, ground braid, or green-wire
ground.

– Use an ESD common ground or reference point when working on a
double-insulated or battery-operated system. You can use coax or
connector-outside shells on these systems.

– Use the round ground-prong of the AC plug on AC-operated computers.

Grounding (earthing) requirements
Electrical grounding (earthing) of the computer is required for operator safety and
correct system function. Proper grounding of the electrical outlet can be verified by
a certified electrician.
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Appendix D. Product warranty information

This chapter contains the warranty period for your product and the IBM Statement
of Limited Warranty.

Warranty period
This warranty period varies by country or region.

Machine: Model G02

Country or region Warranty period

United States and Canada Parts - 3 years, labor - 1 year

Notes:

v Contact your place of purchase for warranty service information. Some IBM
Machines are eligible for on-site warranty service depending on the country or
region where service is performed.

v A warranty period of 3 years on parts and 1 year on labor means that IBM will
provide warranty service without charge for:

1. Parts and labor during the first year of the warranty period

2. Parts only, on an exchange basis, in the second and third years of the
warranty period. IBM will charge you for any labor it provides in performance
of the repair or replacement.

IBM statement of limited warranty
Refer to the IBM Statement of Limited Warranty document that came with your
appliance for detailed information about the country-specific warranty information.
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Readers’ Comments — We’d Like to Hear from You

IBM TotalStorage NAS Gateway 300 Model G02
Installation and Initial Setup Guide

Publication No. GA27-4331-00

Overall, how satisfied are you with the information in this book?

Very Satisfied Satisfied Neutral Dissatisfied Very Dissatisfied
Overall satisfaction h h h h h

How satisfied are you that the information in this book is:

Very Satisfied Satisfied Neutral Dissatisfied Very Dissatisfied
Accurate h h h h h

Complete h h h h h

Easy to find h h h h h

Easy to understand h h h h h

Well organized h h h h h

Applicable to your tasks h h h h h

Please tell us how we can improve this book:

Thank you for your responses. May we contact you? h Yes h No

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you.

Name Address

Company or Organization

Phone No.
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